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Time Savers in the  

Title Tool
In this chapter, we will cover:

 f Opening the Title Tool and setting preferences

 f Methods to save a Title

 f Revising a Title: Two methods

 f Creating and/or recreating Title Media in a Bin

 f Creating and/or recreating Title Media in a Sequence

 f Creating and using Title Styles

 f Creating and using Title Templates

Introduction
Media Composer comes equipped with two titling applications. One is relatively 
uncomplicated, and is simply called the Title Tool, while the other is a 3D animation 
application called Marquee. This chapter will discuss the Title Tool, and will focus on  
some procedures and features that can save time and which often go unused.

It should also be mentioned that there are additional titling capabilities provided in the Effect 
Palette (Tools | Effect Palette). In the left column of the Effect Palette, you'll see a category 
of effects labeled as Avid FX. Within that category, you'll see an effect named Avid FX Filter. 
This is actually licensed from Boris FX and is a package of effects also known as Boris Red. 
For more information, visit http://www.borisfx.com/Avid-FX/.

While far from being as powerful as Adobe's Photoshop, Avid's Title Tool is still a useful tool 
for creating slates, footage placeholders, Lower Thirds, a credits roll at the end of a film, or 
even a text scroll like we frequently see on news television.
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There are a few things to be aware of when using the Title Tool:

 f In Version 6, the Title Tool is actually a separate application that is launched when 
you choose to use it.

 f In Version 6, when the Title Tool is launched, it will have its own pull-down menus  
at the top of the screen. The two menus (and their selections) to familiarize yourself 
with are the Object Menu and the Alignment Menu. Note that in previous versions  
of Media Composer that the Object Menu and the Alignment Menu are added to  
the right-hand side of the existing pull-down menus.

 f Titles are created based on the format settings in place in the Project Window | 
Format tab. For example, titles can be 4:3 or 16:9, SD or HD.

 f You do not have to have a Sequence in the Timeline window in order to create or 
revise a title in a bin.

Opening the Title Tool and setting 
preferences

When you first tell Media Composer that you want to create a title, you'll be asked which titling 
application you'd like to use. Let's take a look at how to open one of the titling applications 
and how to set a preference if you'd like to. 

How to do it...
1. You can open the Title Tool using either of these methods:

 � Clip Menu | New Title…

 � Tools Menu | Title Tool

2. The first time you ask Media Composer to make a title, you will be presented with  
a small dialog window which asks which application you'd like to use, along with  
if you'd like that selection to be the default for the future. Your choices are:

 f Marquee: This checkbox launches the Marquee three-dimensional  
titling application.

 f Title Tool: This checkbox launches the traditional Title Tool application.

 f Persist?: This checkbox allows you to set a default preference when making 
future titles without having to go to the settings tab. Refer to the following:.
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 � Unselected/Unchecked: Leaving this unchecked will mean that each  
time you ask to create a title, you will be presented with a dialog window, 
allowing you to choose which tool you'd like to use at that moment.

 � Selected/Checked: If you check this first, and then click either the Marquee 
button or the Title Tool button, then you are setting a default preference. In 
the future, whenever you ask to create a new title, you will not be presented 
with the dialog window. Instead, it will immediately open whichever 
application you selected as your preference.

3. You can adjust your preference at any time by going to: Project Window | Settings 
tab | Marquee Title. Opening the Marquee Title settings will allow you to:

 � Create New Title Using: This sets the tool preference when you ask to create 
a new title. Choosing Ask me will tell Media Composer to once again present 
you with the small dialog window, allowing you to choose which tool you'd like 
to use at that moment.

 � Promote Title Tool titles to Marquee: This sets a preference for how you'd 
like Media Composer to treat your existing titles when you open them to be 
revised. The two methods for revising a title are discussed in this chapter.

 � Backup Titles on Promote: This creates a back-up copy of Title Tool titles  
if/when they are promoted to Marquee. Avid states, "The backup copy is a 
fast-saved (unrendered) title with [TT] added to the name of the back-up copy 
to differentiate it from the newly created Marquee version". I'll add that the 
two methods to recreate (render) the title media are also discussed in  
this chapter.

Methods to save a Title
This topic is helpful when you need to create multiple, similar titles one after the other. I have 
seen some editors repeatedly opening and closing the Title Tool, and creating each title one 
at a time. I hate to see folks working harder than they need to.

Getting ready
Open the Title Tool (as discussed in the previous section) and make a title. Do not save the 
title yet.

How to do it...
This recipe presumes you have created a title and adjusted one or more attributes such as 
font, color, border, shadow, and so on.
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When it comes time to save a title you have several options:

 f Close or Quit the Title Tool – when you close or quit the Title Tool, you will be asked  
if you want to save the title. After going through the Save Title dialog window, then 
the Title Tool will close/quit.

 f File Menu | Save Title (cmd/Ctrl + S): This will save the title, saving the changes 
on top of (that is, updating) the title you are working on. It will leave the Title Tool 
open to allow you to continue to work. Caution: If after completing a title you move 
on to making a new one, do not simply "Save" the title; instead use "Save Title As," 
otherwise you will be replacing (saving on top of) the previous title.

 f File Menu | Save Title As (Shift +Cmd/Ctrl +S) – This will save the title as a separate 
clip from any other title. This allows you to keep the Title Tool open in order to create 
a number of titles at a time. For example, you created a title card for Produced by 
Mike McNulty and you chose a font, font size, and font color; you added a drop 
shadow, and centered the text both horizontally and vertically in the frame. 

Knowing that you want the next title card to have the same attributes, you would 
perform a Save Title As. This will keep the Title Tool open, allowing you to simply 
adjust the text for the next title card to read as Directed by Røk Svitchbørd, and then 
once again select Save Title As to make sure that Røk's title is separate from the 
previous one. You would then repeat the process for Written by Ron Manfried, Edited 
by Burt Hershel, Music by, and so on (each time using "Save Title As") without ever 
having to close the Title Tool. Also note that after you complete the final title, you still 
need use Save Title As before you close the Title Tool.

Revising a Title: Two methods
Each method of revising a title (in a Bin or in a Sequence) produces a different result. Let's get 
an overview of both methods before we cover the specific steps:

 f Revising an existing title from within a Bin – when you use the recipe to revise an 
existing title from within a bin, it means that:

 � You will have the option to save the changes on top of the previous version, 
which updates the existing title in the bin.

 � You will have the option to save the title as a new and separate title  
(a different version), using the Save Title As command from the File menu.

 � Revising a title from within a Bin does not update any instances of that  
title which have been edited into your Sequence. In other words, if you've 
edited the title into a Sequence(s), then the title in the Sequence(s) will  
not be affected.
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 � Editing a title which was revised from within a bin over an existing title in 
a Sequence (that is, replacing it) means that you will lose your keyframe 
animation (however, there is a method to save a template of just the 
keyframe animation from the title before it is replaced, which can be applied 
to any title in the future. See the next section titled Saving a Title's keyframe 
animation for details).

 f Revising an existing title from within a Sequence – when you use the recipe to revise 
an existing title from within a Sequence, it means that:

 � Once the revision is completed, the title will be updated in the Sequence. This 
means that any keyframe animation you already applied will be retained.

 � The original version of the title is retained in the bin (that is, the original 
remains unchanged).

 � The revised version of the title will be created and a new Title Clip will be 
placed in a bin.

How to do it...
First, let's cover how to revise an existing title that's in a Bin:

1. Select the title you want to revise in the bin.
2. option/Alt + double-click on the title's icon. Note that this key combination is a 

somewhat recent change. If you find yourself on an older release of Media Composer, 
you may need to cmd/Ctrl + double-click on the title's icon.

3. Whichever titling application created that title (Title Tool or Marquee) will be 
launched. This recipe discusses the traditional Title Tool only.

4. Revise the title.
5. Do one of the following:

 � Close or Quit the Title Tool: This will present you with a dialog box asking if 
you want to save the changes to the title. If you press Save, then the changes 
will overwrite and update the original.

 � File Menu | Save Title: This will save the changes which will overwrite and 
update the original. It will also leave the Title Tool open for you to continue to 
make more titles. Be cautious that after making additional changes, if you do 
not want to update the original, then you must select Save Title As. Selecting 
Save Title As will create an entirely new and separate title from the original.

 � File Menu | Save Title As: This creates an entirely new and separate title 
from the original. It opens the Save Title dialog window which allows you 
to rename the new title, select a different resolution, and so on. It will also 
leave the Title Tool open for you to continue to make more titles. Be cautious 
that after making a new title, if you do not want to update the original, then 
you must again select Save Title As.
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Now let's go through the steps of revising a title that has been edited into a Sequence:

1. Enter Effect Mode, or open the Effect Editor: Tools Menu | Effect Editor.

2. In the Sequence, select the title you want to revise.

3. In the Effect Editor window (just above the Foreground parameter), you will see 
a small, square button labeled as Edit Title. Select this small, square button. 
Whichever titling application created that title (Title Tool or Marquee) will be 
launched. This recipe discusses the traditional Title Tool only. For anyone on an older 
release of Media Composer, without the Edit Title button, see the There's more... 
section later for details on the Other Options button.

4. Do not close the Effect Editor window. It must remain open in order for the process 
to work correctly.

5. Revise the title. 

6. Do one of the following:

 � Close or Quit the Title Tool: This will present you with a dialog box, asking if 
you want to save the changes to the title. Unlike revising a title from within 
a bin, Media Composer will not only update the title that is already in the 
Sequence, but will also create a new and separate version in the bin; and it 
appends the name with .01. Media Composer places the new title into the 
same bin that holds the active Sequence.

 � File Menu | Save Title – same result as Close/Quit the Title Tool.

 � File Menu | Save Title As: This opens the Save Title dialog window which 
allows you to name the new title, select a destination bin, and so on. Once 
the title has been saved, the Title Tool will close.

There's more...
If you are using an older release of Media Composer, when you select a title while in Effect 
Mode, then there may not be an Edit Title button. In earlier releases, titles will have what Avid 
calls the Other Options button. You'll find this small, rectangular button in the upper, left-hand 
corner of the Effect Palette, just to the left of the text that reads Title. Clicking on that small 
button will launch whichever titling application created that title (Title Tool or Marquee).

Saving a Title's Keyframe Animation
If you've animated a title, and you'd like to save this animation, so that it can be applied to any 
title in the future, then you'll follow these steps:

1. Enter Effect Mode or open the Effect Editor: Tools Menu | Effect Editor.

2. In the Sequence, select the title from which you want to save the keyframe animation.
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3. In the Effect Editor window, you will see what Avid calls the Effect Icon in the upper-
left corner. In this case, the icon will have a large letter T on it and have text next to it 
that reads Title.

4. Press and hold down the option/Alt key.

5. While continuing to hold down the option/Alt key: Click on the title's Effect Icon and 
then drag-and-drop it into any open bin.

6. Notice that at the end of the title's name, you will see (Without Src). This means 
without source. In other words, you have just saved the keyframe animation 
information separate from the title information (for example, the words you typed, the 
colors you chose, and so on.).

7. This Title Effect Template can only be used on other titles. To use it, simply drag-and-
drop it onto another title in a Sequence and the keyframes will be instantly applied. 
Also note that if you place the template onto a title which is shorter or longer than 
the one used to create the template, then Media Composer will adjust the keyframes 
proportionately.

Creating and/or recreating Title Media in a 
Bin

If for any reason a title(s) is Offline you can recreate its media. Media may be offline because 
the media was deleted, or because the title was created as an unrendered "Fast Save" version. 
It is also possible to recreate a title's media at a different resolution. This would be useful for 
example if you mistakenly created the title at 20:1 and you actually want it to be 1:1. 

How to do it...
1. First, you have two options:

 f If the Title Media is Offline, then skip to step 2.

 f If the Title Media already exists (that is, Online), then you must first delete 
the media before you can tell Media Composer to recreate it. Again, this 
would be useful making a title created at a resolution of 20:1 into being at 
1:1. If this is the case, then follow these steps:

i. Select the title(s) in the bin.

ii. Press the Delete key on the keyboard.

iii. The Delete dialog window will open.

iv. Deselect the first option that reads Delete 1 effect clip(s).  
For emphasis, uncheck this box. This relates to the information 
about your title (for example, the text you typed, the colors you 
chose, and so on.), and you do not want to delete it.
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v. Do select the second option that reads Delete 3 associated 
media file(s).

vi. In the section titled Resolutions to Delete:, make sure that all 
the check boxes are indeed selected.

vii. Click the OK button. 

viii. A second dialog window will open, asking you to confirm that 
you want to delete the media.

ix. Click the Delete button. The title's media will now be Offline.

x. Continue on to step 2.

2. Select the Offline title(s) in the Bin.

3. Go to Clip Menu | Create Unrendered Title Media.

4. The Create Unrendered Title Media dialog window will open.

5. Select a drive to place the new media that will be created.

6. Select a resolution for the media.

7. Click the OK button.

8. The media will be created and Media Composer will append the name of the title with 
.0. The recreated title(s) will appear at the top of the Bin.

Creating and/or recreating Title Media in a 
Sequence

This process allows you to either create title media for titles which are Offline, or to recreate 
title media at a different resolution (for example, making a title with a resolution of DNxHD 36 
into DNxHD 220). Unlike the previous method, you do not have to first delete any title media if 
it already exists (that is, is Online). 

How to do it...
1. Enable the Track Selector(s) for tracks that contain a title(s) you want to recreate 

media for.
2. Depending on the number of titles, choose one of the following options:

 � If you are recreating media for one title, then simply place your blue Position 
Indicator on that title

 � If you are recreating media for multiple titles, then place a Mark In and a 
Mark Out around the titles to select a range of titles to affect

3. Go to: Clip Menu | Re-create Title Media.
4. The Re-create Title Media dialog window will open.
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5. Select a drive to place the new media that will be created.

6. Select a resolution for the media.

7. Click the OK button.

8. The media will be created for each and every title. In other words, if you Marked In/
Out around a range of six titles, then you will be given six new title clips in the bin. 
Media Composer will append the name of each title with .0. The recreated title(s) 
generally appear at the top of the same Bin as the active Sequence.

Creating and using Title Styles
Title Styles allow you to make your own personal library of attributes, which are saved 
within your personal User Settings, that can later be applied to text (or even to objects like 
rectangles, ovals, lines, and so on.) in order to save you time and effort. For example, maybe 
you're frequently making placeholder slates for footage or scenes that you're waiting on, and 
you want all the slates to be uniform. You want them to always have the same font, size, color, 
border width, leading (the space between multiple lines of text), and justification (for example, 
centered), and you'd prefer not having to set each of those attributes one at a time whenever 
you make a placeholder slate. That's what Title Styles can do for you in just one step. After 
the recipe, in the There's more... section, we'll cover how to apply a Title Style to existing text 
or objects. 

How to do it...
First we'll go through the process of making a Title Style:

1. Open the traditional Title Tool: Tools menu | Title Tool. See the Opening the Title 
Tool application and setting preferences recipe for more information, if required.

2. Create a title with some text (one line or multiple lines). Adjust attributes such as  
(but not limited to):

 � Font

 � Font size

 � Justification

 � Kerning (the space between letters)

 � Leading (the space between lines of text)

 � Color

 � Border width

 � Border color

 � Transparency

 � Shadow
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3. Select the modified text by either:

 � Enable the Selection Tool (arrow button) and then select the textbox that 
holds the text

 � Enable the Text Tool (large letter T button) and then use the cursor to 
highlight the modified text

4. Go to the Save Style Parameter Menu (circled in the next screenshot):

5. Select Save As.

6. The Title Style Sheet Window opens (see the next screenshot):
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7. Select just specific attributes to be saved or leave them all selected. I just leave them 
all selected, since changes can always be made after a Title Style has been applied 
to text or an object in the future.

8. Assign a Function Key that will apply that set of attributes (see letter A in the 
previous screenshot). Note that for those using a PC (rather than a Mac), the F1 key 
is not assignable (it is reserved for launching the System Help). 

9. Name the Title Style (see letter B in the next screenshot). I find that naming it for its 
purpose (rather than after the font name) is most helpful. For example, Placeholder 
Style 1, Placeholder Style 2, Temp Lower Thirds, and so on. You can change the 
name of, or delete, Title Styles from your settings. See the There's more... section 
later for details.

10. Click the Done button. 

There's more...
Here we'll cover how to delete, access, and apply the Title Styles you've created.

 f You can change the name of, or delete, Title Styles from your settings: Project 
Window | Settings Tab | Title Style. See the Settings overview recipe in Chapter 
2, Customizing Your Work Environment for more information on User Settings in 
general, and deleting settings specifically.

 f Title Styles are accessed/applied using any of the following three methods:

 � Using an assigned F key – if you assigned an F key in step 8, then you can 
select text or an object in the Title Tool and press that F key to apply the 
attributes of that Title Style.

 � From the Save Style Parameter Menu, your Title Style will appear in a text 
list above the Save As command as seen in the following screenshot:
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 � From the Title Styles Palette, click on the Styles menu button (circled in 
the next screenshot) to open the menu/palette in order to have a visual 
reference of the different styles you created (see the next screenshot). Once 
open, you can enlarge the palette window by grabbing the bottom, right-hand 
corner and dragging it to the right. You can also scroll back and forth through 
your library, using the scroll arrows that are on the left-hand and right-hand 
sides of the palette window. To apply one of the Title Styles from your library, 
first, select the text or object, and then click on one of the displayed buttons 
in the palette window.

Creating and using Title Templates
Title Templates are actually files that you save (for example, to your portable flash drive) and 
can bring from job to job to save you time with tedious tasks like making Program Slates. 
This section will take you through making a Title Template for a Program Slate, and saving it. 
Then, in the There's more... section, we'll cover using the Title Template in the future.

How to do it...
In this example, we're going to make a Title Template for a two-column Program Slate. This 
is accomplished by making two separate textboxes. The left-hand column textbox will have all 
the text justified to the right-hand side, while the right-hand column textbox will have all the 
text justified to the left-hand side.

1. Open the traditional Title Tool: Tools menu | Title Tool. See the Opening the Title 
Tool application and setting preferences recipe for more information, if required. 
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2. First, type out all the descriptor information such as Title, Production Number, TRT 
(total running time), and so on, as dictated by your Post Production Supervisor. Place 
each descriptor on a separate line. Adjust the text attributes as needed (for example, 
Font, Size, Color, Leading, and so on.). See the following screenshot:

3. Select the text by either:

 � Enable the Selection Tool (arrow button) and then select the textbox that 
holds the text

 � Enable the Text Tool (large letter T button) and then use the cursor to 
highlight the modified text

4. With the textbox, or text itself, selected, click on the Right Justify Text button  
(circled in the previous screenshot).

5. Using the Selection Tool (arrow button), select the textbox (rather than highlighting 
the text). When selected with the Selection Tool arrow, you'll see eight small white 
squares around your text. These are the adjustment handles which allow you to resize 
the textbox (see the next screenshot).

6. Go to Edit Menu | Copy (cmd/Ctrl + C).

7. Click your cursor in a new location outside of the text you selected, making sure that 
the original text you copied is not selected in any way.

8. Go to Edit Menu | Paste (cmd/Ctrl + V).
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9. Using the Selection Tool (arrow button), select the textbox you just pasted and move 
it to the right-hand side. If you first select the textbox and then hold down the Shift 
key before moving it, then the textbox will be constrained to moving only horizontally. 
That way the text lines will continue to be aligned. If they become unaligned, you can 
always fix this by using the appropriate command from the Alignment menu.

10. With the second textbox still selected, click the Left Justify Text button (circled in the 
following screenshot) to set all the text to align to the left-hand side of the textbox.

11. Adjust the positions of the two textboxes. You can use any of these methods:

 � Nudge them, using the arrow keys on the keyboard

 � Use the commands from the Alignment menu

 � Use the Shift key to select multiple objects and/or textboxes at the same 
time

12. Now that you've created the design for the template, you'll save it as a template file in 
the next steps.

13. Click on the Templates button (Avid calls it the Template Commands Menu).

14. From the Templates menu, select Save Template.

15. The Save Template As dialog window opens.

16. Name the template.
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17. Choose a location to save the Title Template file:

 � By default, Media Composer will want to save it in the Title_Templates 
folder (which is inside the Settings folder that exists inside the Media 
Composer application folder). If you'll never be changing workstations, then 
this is a convenient location.

 � If you'll be changing workstations frequently, then navigate to another 
location where you'd like to save the template file (for example, on your 
removable flash drive, on a server partition, and so on).

18. Click the Save button. Media Composer will save the file as a .pct file.

There's more...
When you want to use a saved title template in the future, you'll follow the steps below.

1. Open the Title Tool: Tools menu | Title Tool.

2. Click on the Templates menu button and select Edit Template.

3. Navigate to your previously saved Title Template .pct file, and select it.

4. Click the Open button.

5. The template appears in the Title Tool. You can now modify it as needed. See the 
next screenshot for an example:

6. Save the title. See the Methods to save a title recipe earlier in this chapter for details.




